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1. INTRODUCTION
Commissioning of the FlexiDim™ system is carried out once the system has been installed and
tested (as described in the FlexiDim™ Installation Guide). The Commissioning procedure takes
from 30-60 minutes, depending on the size of the installation. Once Commissioning is
completed, the FlexiDim™ installation will be ready to hand over to the client or the interior
designer/architect of the property.
The first step in Commissioning involves entering meaningful names for all the Switches and
Circuits/Channels in the system, as well as setting the type of light(s) comprising each
Channel. These settings are central to the operation of the FlexiDim™ system and are unlikely
to be changed except in the case of rewiring or relocation of lights or Switches. A software
program called the “FlexiDim™ Installer Configuration” is supplied to carry out this stage of the
Commissioning process.
The second step in Commissioning involves assigning Channels to Switches in order to obtain
the basic On/Off and Dimming functions prior to Scene creation. Software called the
“FlexiDim™ User Configuration” is used for this process, and the same software is used by the
client to create and manage Scenes after Commissioning.
Both the Installer and User Configuration utilities are Microsoft Windows® compatible.
Any questions arising during Commissioning can be answered by contacting JCL:
Telephone

01507 588558

email

support@jclighting.com
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2. FLEXIDIM™ CONFIGURATION SOFTWARE
INSTALLATION OVERVIEW
The FlexiDim™ Configuration software must first be installed on the PC or Laptop that will be
used to configure the FlexiDim™ system.
Any reasonably modern PC or notebook PC is suitable for running the configuration software,
but the absolute minimum specification is: Intel 486-DX66 CPU running at 66MHz, 64MB RAM,
a screen resolution of 800 x 600 in 256 colours, 10MB of free disk space and Microsoft
Windows® 95 (or later) operating system.
The FlexiDim™ Configuration Software can be downloaded from the MyJCL section of the
website ( www.jclighting.com ). Contact JCL for a username and password if these have not
already been set up.
To download the software, click on the ‘Latest Software’ link in your MyJCL account. Then click
on the Setup program inside the downloaded zip file.

If the Setup program does not start automatically. click on setup.exe

Click the picture button to start installation.
Ensure that the software is installed into the correct directory C:\Program Files\FlexiDim and
not C:\program Files(x86)\FlexiDim. Windows 7 & 8 may try to change the installation path
and if this happens it is important that you correct it.
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Using the default locations and program group helps any subsequent users of the FlexiDim™
system to easily locate the configuration files that have been produced by the Commissioning
process.When installation is complete a confirmation message will appear.
The FlexiDim™ lighting system connects to your building network, so select a connection type
of TCP, enter the IP address of the lighting system which can be obtained using the FlexiDim™
Discovery Utility. The port number is 5273.
Refer to the website www.jclighting.com and select the Manuals link. There is a section on
connecting FlexiDim™ to a network (Configuring FlexiDim™ for TCP Connectivity).
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3. FLEXIDIM™ INSTALLER CONFIGURATION
PROGRAM
Before starting the Commissioning process, ensure that the entire FlexiDim™ system is
powered on (i.e., Scene & Switch Controller and all Dimmer Modules, Mains Relays, etc. are
switched on).
To start the Installer Configuration program, select Start, Programs, FlexiDim™ Configuration,
FlexiDim™ Installer Configuration. The following display will appear:

Site Details

Enter the Site ID which can be found on the Scene Controller case.
Dimmer Modules will have been supplied with sequential serial numbers for the installation,
starting at either 3000 or 7000.
Remove the default Dimmer ID entries for Dimmer Modules that do not exist in the current
FlexiDim™ system (or add the extra entries required for sites with more than 4 Dimmer
Modules). For example, if your installation only has 3 Dimmer Modules, these will probably
have IDs 7000, 7010 and 7020. Therefore, remove the 7030 entry from the screen. Similarly, if
you have more Dimmer Modules (or Relay Modules), and/or different IDs, these should be
changed accordingly.
Click on the Program Dimmer Modules button (bottom right hand corner of the screen) to send
the new Dimmer information to FlexiDim™.
Whilst there is no requirement that the first Dimmer Module in the list is the Dimmer Module
with ID 7000, and the second the one with ID 7010, etc. it makes no sense to have them set
any other way in a new installation. As will be seen, Channels are referred to by their name,
which will be assigned shortly, and the user rarely needs to see or refer to the Dimmer Module
numbers or their IDs.
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The ability to change Dimmer Module IDs is provided for service use in the event of a Dimmer
Module failure.
Note that if any of the IDs for Dimmers are changed at any time, click on the Program Dimmer
Modules button to re-program them for their new positions.
Dimmer Modules must have power applied during re-programming and the Scene & Switch
Controller should also be switched on.
Enter the Longitude and Latitude settings for the site.
This can be done in either in degrees and minutes (format dd’mm), or in degrees and decimal
minutes (format dd.mm where the minutes are represented as a decimal of a minute).
These settings are used by FlexiDim™ to calculate Sunset and Sunrise times for use within
lighting Scenes (this gives the ability to set lights to come on automatically at a time relative to
sunrise or sunset, even though the time of sunrise and sunset changes every day).
Note that these settings can be added to the system at any time, so if you do not have them to
hand now it does not matter; they can be added later. However, if no longitude and latitude
settings have not been entered, then any Scenes that use the Sunset and Sunrise calculations
will assume the settings are 0’00 and 0’00 (i.e., at the equator)!
Hint: to find out the longitude and latitude settings for the site you can use Google Maps
(enter the postcode of the site and then right-mouse click on the marker and select ‘What’s
Here?’ which will display the coordinates).
Finally, choose the connection type of TCP.
The display should now show the Site ID, the Longitude and Latitude coordinates (if available)
and have any unused Dimmer Module IDs removed (or additional IDs added) as well as the
correct connection type for your installation.
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Identifying and Naming Switches
The next step in the Commissioning process is to detect and give names to each of the
Switches in the FlexiDim™ system.
Select the Switches option from the View menu which will display an empty list of 64 Switches
and their type (currently ‘Not used’).
Select the Detect Switch Types option from the Tools menu.
After about 45 seconds, all of the FlexiDim™ Switches that have been connected to the system
will have automatically identified themselves. They will appear in blue in the column on the
right, complete with their button type/description.

Now select Identify Switch from the Tools menu, and the following popup display will appear:

Go to the actual (physical) Switch Plate that is about to be named and press any one of its
buttons in order to identify it to the Installer Configuration software.
The corresponding entry line on the software display will be highlighted and a meaningful
name can be entered (see below).
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Repeat the above process (from selecting the Identify Switch option on the Tools menu) for
each Switch in the installation, until names have been entered for all the Switches on the
FlexiDim™ system.
Note that if the wiring schematic for the FlexiDim™ system is available, then the switch names
can be entered without identifying all switches. However it is always advisable to perform a
physical check as well.

Example of the completed Switch information display:

Remember to regularly Save the information that has been entered by selecting Save from the

10

File menu. A message will confirm that the Save operation has been successful.
The Installer Configuration file will always be saved into the FlexiDim™ directory that was
specified during the software Setup (this cannot be changed). The filename will be the same as
the Site ID (without the separating colon), for example, if the Site ID is 0734:0002, the
resultant Installer Configuration filename will be 07340002.
Note that this file cannot be renamed.
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Identifying and Naming Channels
If the FlexiDim™ installation process has been carried out with reference to plans or drawings
detailing the lighting circuit connected to each Channel of each Dimmer Module and the
location of Switches and their connection used on the Switch Controller, it might be helpful to
have this information to hand during Commissioning. If not, it really doesn’t matter as there
are plenty of ‘easy identification’ capabilities embedded in the configuration software.
Select the Dimmers option from the View menu (shortcut: Ctrl+D), and the following entry box
will be displayed:

There are several parts to this display:
Along the top are buttons that switch between each of the Dimmer Modules in the FlexiDim™
installation. These are labelled Module 1, Module 2, etc. Only the number of Modules
previously confirmed for the installation is highlighted.
Selecting one of these Module buttons (once this display has been completed) will highlight it
and the following information for each of the 8 Channels on that Dimmer Module will be
displayed:
The Channel name
The Profile of the lamp connected to that Channel (selected from the drop down list of

available types, determines the minimum and maximum brightness settings for the Channel)
as well as determining how the lamp is driven.
The Minimum and Maximum dimming range available (percentage). Note that 0 is equivalent

to ‘off’, therefore the Minimum is the lowest level that is available above off. These values
are set automatically by the Lamp Type selected unless type ‘Custom’ is required, in which
case the minimum and maximum levels are entered manually.
The Default brightness for that Channel. This is only used in case of system failure, and as

such is usually only programmed for key Channels (such as exit routes).
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Dimmer Channel Name
The selected Channel is shown with its number on the left of the display highlighted in blue
(the highlight indicating that the information for that Channel can be modified). The Channel
selection is changed by clicking on the Dimmer Channel name entry box or the Lamp type drop
down list of the next required Channel.
To enter the Dimmer Channel Name, simply click on the Channel to ensure that it is
highlighted (the cursor will be flashing in the Name box) and type in the Channel Name.

Profile
On/Off This setting is used for lights (or appliances included in the FlexiDim™ system) that are
not dimmable and therefore only have these two absolute values. Any value above0% will result
in the channel being fully on.
Dimmable This setting is used for conventional tungsten lamps, mains voltage halogen and
low voltage halogen with a dimmable transformer. These can be dimmed between 0% and 100%
On/Off hard fired This setting is the same as On/Off, except that the drive to dimming
circuitry is kept turned on throughout most of the cycle. This prevents flickering with certain
types of load.
On/Off full cycle This setting is the same as On/Off hard fired, except that the drive to
dimming circuitry is kept turned on throughout all of the mains cycle. This accommodates
small loads that are not drawing sufficient current to keep the circuit fully turned on
throughout the mains cycle.
Dimmable hard fired This setting is the same as Dimmable, except that the drive to dimming
circuitry is kept turned on throughout most of the cycle. This prevents flickering with certain
types of load.
Dimmable cycle This setting is the same as Dimmable hard fired, except that the drive to
dimming circuitry is kept turned on until the end of the mains cycle. This accommodates small
loads that are not drawing sufficient current to keep the circuit fully turned on throughout the
mains cycle.
Custom This setting allows the Minimum and Maximum values to be manually changed in
order to accommodate any unusual or non-conventional Lamp types. An example of a Custom
Lamp type is a lighting unit which can not be dimmed below 50% due to the type of ballast or
transformer that supports it. In this case, 50 would be entered as the Minimum value.
Dualled (Channels 2,4,6,8 only) This setting links the channel operate with the channel
immediately before it. i.e. 1 & 2, 3 & 4, 5 & 6 or 7 & 8. In this way, the maximum load may be
increased to 1000W for the circuit. A link must be inserted between the Live connections for
the two channels. The channel should not be given a name, as it will now be controlled by
reference to its neighbour.

Def (Default Brightness)
This setting is used to provide key lights in the unlikely event of a system failure. For example,
hall, stairs and landing lights could be set to 100 (i.e., fully on).
Only key lights are given a default brightness, so that if the system failed in the middle of the
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night, the entire house would not be bathed in bright light.
Note that system failure should not be confused with a power cut; none of the lights will be
able to work during a power cut unless separate emergency lighting provision has been made.

Channel Identification Tools
A number of ‘tools’ are included on this screen for easy identification of each of the Channels
on the Dimmer Module.
At the bottom of the display is a Slider control that can vary the brightness level of the
selected Channel. As the slider is moved, the Brightness of the actual lamp(s) in the selected
Channel changes immediately and the current brightness is displayed as a percentage.
The Flash Channel option causes the selected Channel to alternate between 0% and 100% at 1
second intervals.
The All On and All Off buttons switch all 8 Channels on a Dimmer Module fully on and fully off
respectively. All Channels on other Dimmer Modules are switched off.
The Test button cycles through each Channel on the Dimmer turning the brightness to 50%,
then 100% and then off (and then going to the next Channel on the Dimmer). This is useful as
an installation test to ensure that each of the Channels is wired as expected and working.
The Fade On and Fade Off buttons can be applied to the selected Channel and show that the
dimming range is working as well as helping to identify the Channel.
These tools provide a convenient way to identify one specific, or all Channels connected to a
particular Dimmer Module.
Before starting the process of identifying and naming channels, ensure that any FlexiDim™ wall
sockets have lamps plugged in and switched on, otherwise identification of these sockets will
be impossible.
Once a Channel has been identified, enter a meaningful name for it. Try and avoid names like
ceiling light, as this could be ambiguous. Instead, use fully descriptive names such as
Bedroom1 ceiling light.
When all 8 Channels on a Dimmer Module have been defined, pressing the Send Dimming
Profiles button will program the Dimmer Module with the correct values. The effect of these
limits can be verified using the slider to control the Channel.
Note that at this stage of Commissioning, no correlation or relationship exists between the
Switches that were named in the previous section, and the Channels that are being named
here. That relationship will come a bit later.
An example of a completed Dimmer Module is shown below:
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When all Dimmer Modules have been completed, select Save and then Exit from the File menu.

15

Naming Conventions for Auto-Grouping of Channels and Switches
It is necessary to give both Switches and lighting Channels names that identify them without
any confusion to the user.
Unfortunately, this can result in names that are quite long, such as ‘Downstairs Bathroom wall
light’ and ‘Downstairs Bathroom mirror light’. To help streamline this, FlexiDim™ provides a
naming convention that allows names to be shortened, and then to be placed together by room
or location in the property.
For example:
 Downstairs Bathroom Wall Light

(full name)

 Downstairs Bathroom Mirror light

(full name)

can be represented as:
 Downstairs Bathroom

(group name)

Wall light

(short name)

Mirror light

(short name)

similarly:
 Upstairs Bathroom Wall light

(full name)

 Upstairs Bathroom Mirror light

(full name)

can be represented as:
 Upstairs Bathroom

Wall light

(group name)
(short name)

Mirror light

(short name)

Notice that we have two lights called Mirror light and two lights called Wall light, but their
grouping (under the room they are in) allows us to identify which light we are actually referring
to without using a lengthy name each time.
FlexiDim™ supports a full name, partial name and short name for each switch and lighting
channel. Normally only the full name and short name will be required, unless a very large
installation is be undertaken.
Using the example above, and by entering the Channel names as follows, the FlexiDim™
system can create full and short names as well as creating Groups:
 Downstairs Bathroom!Wall light
 Downstairs Bathroom!Mirror light

and:
 Upstairs Bathroom!Wall light
 Upstairs Bathroom!Mirror light

Note the use of the exclamation mark ‘!’ instead of a space to separate the short name from
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the full name. When the User Configuration program is started (described later in this manual)
and the Site ID is specified, there will be an option to automatically create groups and place the
correct channels in each group. Following this example, the Groups created would be called
Downstairs Bathroom and Upstairs Bathroom, each with 2 circuits in: Wall light and Mirror light.
Using a colon ‘:’ instead of a space, includes the preceding part of the name (as far back as any
exclamation mark) within the partial name, but not the full name itself.
In all cases, the ‘!’ and ‘:’ are replaced with spaces when displaying the name to the user.
The Dimmer Channel display above completed with this naming convention is shown below:

Note that the same naming convention can be used when filling in the Switch details, for
example Switches could be separated in to rooms or simply into floors, such as Upstairs and
Downstairs.
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Module Configuration
This Screen (accessed from the View Menu) allows additional components and options to be
configured for the FlexiDim™ system.

DV10 Dimmer Module
This is used for any FlexiDim™ DV10 Modules that have been installed. These are most
commonly used for controlling and dimming fluorescent lights.
Select the Module Configuration option from the View menu (shortcut: Ctrl+V), and the
following entry box will be displayed in the top left had corner of the screen:

Enter the Module type (for example DV10), the Dimmer Module ID and the Dimmer Channel
number that the Module is operating with.
The Dimmer Module ID can be ‘made up’ but must be unique from any of the existing IDs. It is
advisable to use one of the last Modules (e.g. Module 16) and give it an ID that is obviously not
a standard Dimmer Module. For example 5555. Then select a Channel on that Dimmer to be
the DV10 controlled circuit.
The Dimming Delay is set according to the length of time that the unit takes to ‘strike’ (ie,
switch on); this is typically between 1 and 5 seconds.
Setting this will allow FlexiDim™ to compensate for the delay when incorporating this light in
to a pre-set Scene. For example, if the delay is 2 seconds, and the light is used in a Scene with
a transition time of 5 seconds, then the delay will be taken off the transition time to ensure
that all lights in the Scene reach their final brightness at the same time. To determine the
delay, turn the light on using the slider control in the View Dimmers display screen, and to
time how long the light takes to strike.
The Lower and Upper Limits for the light controlled by this module are set in order to control
the lowest and highest points at which the light will still change brightness. For these types of
lights, this is generally something like 10% and 90% respectively.
To determine these limits, use the slider control on the relevant Channel in the View Dimmers
screen to find the highest and lowest percentages at which the light no longer changes in
brightness. The Lower and Upper values will be the percentage values divided by 10. For
example, a Lower Limit of 12% will give an entry if 1.2, and an Upper Limit of 87% will give a
value of 8.7.
The Default Level for the light has the same use as the Default Brightness option when setting
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up the Dimmer Channels, i.e., it is used to provide key lights in the unlikely event of a system
failure. For example, hall, stairs and landing lights could be set to 100 (i.e., fully on).
Remember to use the Program Module button each time any changes are made.

Blind Controller
This part of the Module Configuration screen is used for Blind/Curtain etc. controllers as
follows:

The Blind ID is the 4-digit code on the Module’s label
The Module ID is the module number that the blind controller will respond to; choose an
unused Module and Channel ID. The Dimmer Module ID can be ‘made up’ but must be unique
from any of the existing IDs. It is advisable to use one of the last Modules (e.g. Module 14, 15
or 16) and give it an ID that is obviously not a standard Dimmer Module. For example 7777.
Then select a Channel on that Dimmer to be the Blind/Curtain circuit.
The Up and Down times can be measured and entered once the Blind is operational. In the first
instance, it is easier to enter a value somewhat greater than the actual required time (for
example 30 seconds), and then to time the Blind yourself and adjust the times accordingly.
Remember to use the Program Module button each time any changes are made.
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Testing Tools
The FlexiDim™ Installer Configuration Utility includes some useful testing, diagnostic and
verification tools which are described below. Note that the use of these tools is an optional
step in confirming that the installation and commissioning have been completed to
specification.

Switch Test
The Switch Test option is found on the View menu. This tool shows all the Switches and their
types that are connected to the system, displayed in terms of the Switches connected to each
Switch Controller.

In the bottom right hand corner of the display is the Key to switch types which lists the switch
types currently defined (including a type for ‘not used’).
The bottom left hand corner of the display shows each of the Switches connected to each of
the Switch Controllers.
Every 30 seconds, the Switch Controllers identify each of the Switches connected to them by
their type (as per the Key to switch types) and this is shown in the display next to the Switch
Controller number. Pressing the Reset button will clear the display, which will be refreshed the
next time the Switch Controllers identify their Switches.
This tool also allows each Switch Button to be individually tested. This is done by physically
pressing all of the buttons on a Switch Plate. The display will register each Button press and
display the results in the top right hand window. The Switch number is given by its position on
the Switch Controller display below (Switch Controller 1 contains the Switches numbered 1-16,
Switch Controller 2 has Switches numbered 17-32, etc). The button number is taken from the
button’s location on the Switch Plate working from top left to bottom right and omitting
buttons that do not exist on the Switch itself.
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The Mode Menu
Some FlexiDim™ systems are installed with two identical Switch and Scene Controllers (Main
and Backup) in order to give full resiliency in the unlikely event of a failure. (Note that this type
of system is the exception rather than the norm).
This Menu allows a choice of which of these Controllers interprets the commands sent to the
FlexiDim™ system during testing.
When using the Switches or Switch Test screens, the ability to selectively change from the Main
to Backup parts of the system can be used to check that the wiring of the Switch connections
on the Backup Switch Controller is identical to that of the Main Switch Controller.
In the same way, when using the Dimmers screen from the View menu, the test program
communicates with the Dimmers via the Main or Backup circuitry according to the Mode menu
selection.
This Mode option could also be used in the event that you know for certain one of the Scene or
Switch Controllers is faulty and want to continue with the commissioning process rather than
waiting for the replacement unit in order to do so. In normal circumstances configuration
would take place via the default setting which is the Main Controller (Via Main SC).
The Direct Dimmer Mode option is only used for testing and diagnostics during manufacture
and has no specific use during Commissioning.
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4 FLEXIDIM™ USER CONFIGURATION PROGRAM
Next we will use the FlexiDim™ User Configuration utility to complete the Commissioning
process.
Whilst everything required to complete Commissioning is contained here in the Commissioning
Guide, a full description of the features and capabilities of the User Configuration software can
be found in the FlexiDim™ User Guide.
The purpose of this final step of Commissioning is to assign the Channels to the Switches, as if
they were wired in the conventional way. This provides the basic On/Off and Dimming
functionality for the lights in each room or area of the property prior to any Scenes being
created by the client or their interior designer/architect.
To start the program, select Start, Programs, FlexiDim™ Configuration, FlexiDim™ User
Configuration Utility. The following display will appear:

Loading the User Configuration Details
Enter the Site ID, which can be found on the Scene Controller case, and click the ‘Load Details’
button, and the following prompt will appear:

If the Installer Configuration was completed using the naming convention to allow Groups to
be automatically created (see section entitled ‘Naming Conventions for Auto-Grouping of
Channels and Switches’ above), then answering Yes to this prompt will cause those Groups to
be created. Note that if unsure, try answering ‘Yes’ anyway as this will have no detrimental
effect if the naming conventions were not used.
The Switch and Channel names that have been previously entered in the Installer Configuration
are shown.
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In the example above, the naming convention for Grouping has been used, and in the one
below it has not:

To tidy up the display, Groups can be moved and changed by dragging and dropping the
Switch or Channel names.
Group names can be edited by clicking on them and using the F2 (Edit) key.
The right mouse click can be used to Add or Delete Groups.
The contents of Groups can also be sorted alphabetically using the Sort Group option on the
right mouse menu.
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Creating Channel to Switch Assignments
Channels are assigned to a Switch in order to create the same functionality as a conventional
lighting dimmer switch.
Click on a Switch (in the list of switches on the left of the screen) and its name will appear
above the box labelled Channels assigned to switch: <Switch name>.
For each Switch in turn, drag the Channels that should be assigned to that Switch and drop
them on to the list. Using a right mouse click on either a single Channel or a Channel Group
and selecting Add to Assignments is another way of copying from the complete list of
Channels to the list of Channels assigned to a Switch. Remove Channels from those assigned to
a switch by using a right mouse click and Remove Channel.
To drag and drop, click on the Channel and hold the left mouse button down, and as the
mouse cursor is moved (still with the button held down), the cursor will change to a ‘no-entry’
symbol. When the mouse moves over the ‘Channels assigned to switch:’ list, the cursor will
change again, indicating that the Channel information can be dropped in that area. Release the
mouse button to complete the operation.

Start by assigning all the Channels in the same room or vicinity to the Switch for that area.
These can be modified later, when creating lighting Scenes, but for now this is a good starting
point and gets the FlexiDim™ system working (see example above).
The other settings on this screen do not need to be set at this stage, and are explained in full
in the FlexiDim™ User Guide, however a brief overview is given here:
Assign for Off, Assign for On, Assign for Dimming
Set on a per Channel basis, these settings dictate what action the On/Off button has on the
selected Channel. For example, the main lights in the room will be assigned for all 3 settings
(On, Off and Dimming), but some of the peripheral lights may not be. In a kitchen, the incupboard lights may be assigned for Dimming and Off only, and as such do not automatically
come on with the On button, but will be used within Scenes set up for that room. Assigning
them for Off ensures that they are switched off with all the other lights in the room. Lights that
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are non-dimmable would obviously not have Assign for Dimming selected.
On/Off times
These are set for the Switch (i.e., all the Channels in the Assignment) and dictate the transition
(or fade) time for On and Off, ranging from Immediate (0 seconds) up to 2 seconds. Select your
preference from the drop-down list. The default settings are Immediate On and Off over 1
second (try varying these settings, as they give quite different results).
Off/On Priority
This setting dictates what action is taken when the On/Off button is selected after a Scene. For
example, if the lights are at quite low levels in the Scene, do you want the next press of the
On/Off button to turn all lights Off or to turn all lights On? As a rule of thumb and for safety
reasons, key routes in the property exits and stairs, etc.) should have On Priority assigned in
case of an emergency (so that pressing the On/Off button will turn all lights on fully). However,
in a bedroom you will probably want Off Priority selected (so that using On/Off from a lowlevel scene will turn all the lights off).
Select Save from the File menu (or Save As if this is the first time the file has been saved).
The User Configuration file can be saved anywhere on the PC’s hard disk, but the initial default
location is in the same directory as the program (C:\Program Files\FlexiDim). It is inadvisable
to change this default location unless for a specific reason (keeping all he files in the default
directory makes it much easier when searching for these files later).
The Save dialogue box will prompt for a file name to be entered. This file name can be
whatever the user wants, however it is sensible to give it a meaningful name, such as that of
the property, for example, MeadowHouse.
Once saved in this way, the file name is displayed in the Title bar of the User Configuration
utility.
The flexibility offered here allows several different User Configurations to be created for the
same property, for example, users may want different summer and winter configurations, or
maybe one with a specific set of Security Sequencing to run during holidays away from the
property. These and all other features are covered in detail in the FlexiDim™ User Guide.
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Testing the Switch Assignments
Select Emulate (Testing) from the Mode menu. The display will change to display Emulation
Mode (via Main) in the top right hand corner of the display.

In Emulation Mode, the PC (rather than the Controllers) is receiving the button press
information from Switches and sending out the commands to the Dimmer Modules.
Note that the Controller that is running the system is also displayed (in this case the Main
Controller). This part of the display is for information only and cannot be changed except by
switching the currently used Controller off in order to force the system to failover to the other
Controller.
Now that the system is in Emulation mode, pressing the On/Off and Dimming buttons on a
Switch will actually control the light(s) assigned to that Switch.

Test all the Switches for basic On/Off and Dimming functionality.
At this stage, modification of any of the Channel to Switch Assignments can be done whilst in
Emulation Mode using the methods described above in ‘Creating Channel to Switch
Assignments’.
In Emulation Mode, you can also use the Preview slider in the bottom right hand corner of the
screen to interact with the selected Channel. This helps with positive identification of any
Channels whose names may be unclear or ambiguous.

Grouping
Note that Grouping achieves practically the same result as using the Naming Conventions for
Auto-Grouping (described towards the end of the Installer Configuration Utility chapter above).
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The only difference between the two methods is that Grouping (as described here) does not
make provision for the use of Full, Partial and Short names for Switches and Channels.
It can be seen from the completed User Configuration display on the next page that both the
Switches and Channels are arranged into groups. This is strongly recommended and will save
considerable time during the remainder of the User Configuration process.
Grouping Switches (for example into Upstairs and Downstairs, as in the example below) makes
navigation and finding Switches quicker and easier. Similarly, grouping the Dimmer Channels
(for example, into rooms or areas as in the example below), makes navigating the list a lot
easier as it can be compressed and expanded by group.
New groups can be created in both the Switches and the Dimmer Channels lists by clicking the
right mouse button on the Dimmer Channels or Switches heading (or on a previously created
group), and selecting Add Group from the popup menu. The group name can be changed at
any time by selecting the group and pressing the F2 (edit) key.
Similarly, groups can be deleted by selecting them with the right mouse button and choosing
Delete Group from the popup menu.
Channels and Switches are arranged into groups by dragging and dropping. Groups can also
be arranged in the same way. The groups for Switches and Channels are independent of each
other, allowing the most useful layout to be created for each. Typically the groups for Channels
will be more extensive, simply because there are more Channels than Switches.
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Hint: When creating Switch Assignments, simply right mouse click on a Group name and select
Add to Assignments to add all the Dimmer Channels in that Group to the selected Switch. To
sort groups alphabetically, right mouse click on the group at the top of the hierarchy and
select Sort Group.

Changing Switch and Channel Names
The Switch and Channel names are changed using the Installer Configuration software.
To do this, Save and Exit the User Configuration and re-open the Installer Configuration file
that has previously been saved (using the Site ID).
Select either Switches (for Switch names) or Dimmers (for Channel names) from the View menu
as required and edit the existing entries by simply selecting them and typing the new names
in. Remember to Save the file prior to Exit.
If desired, the Naming Convention for Auto-Grouping can also be applied at this stage (see the
relevant section in the previous chapter for details).
Now re-open the User Configuration file and the changed Switch and/or Channel names will be
in place.
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Downloading the Configuration to the Scene Controller
In Emulation Mode, the PC (rather than the Scene Controller) is receiving the button press
information from the Switches and sending out the commands to the Dimmer Modules.
To allow the PC to be disconnected, the configuration information needs to be downloaded to
the Scene Controller so that FlexiDim™ can function in Run Mode (without the PC being
connected).
When the configuration is ready and has been tested in Emulation Mode, select Download
Configuration from the Download menu.
Wait while the configuration downloads. This takes about 2 minutes and includes a verification
test. In the unlikely event that the download or verification fails, follow the on-screen
instructions for fault-finding.
When completed, the program will switch back to Run Mode and a confirmation message is
displayed with the verification (CRC) code. The Scene Controller (as opposed to the PC) has
now taken over full operation of the FlexiDim™ lighting system.
Select Make Permanent from the Download menu. This causes the Scene Controller to write the
configuration information to a part of its memory that will not be lost in the event of a power
failure. This process takes approximately 30 seconds and is also followed by a confirmation
message.

Creating Back-Up Files
It is always advisable to create a backup of both the Installer and the User Configuration files.
Copies of both the Installer and User Configuration files can be saved to your MyJCL account
via the website. We strongly advise you to do this in order to avoid losing the configuration
files as a result of a PC or laptop failure, etc.
The PC can now be disconnected and the system handed over to the client or whoever will be
creating the scenes, etc.
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Setting the Scene Controller Time
It is very important that the Scene Controller time is correctly set during configuration of your
FlexiDim™ system, as this information is used for any timed Scenes that are subsequently set
up.
During this process, the time (and date) sent to the FlexiDim™ Scene Controller is taken from
the PC that is being used. Therefore it is important to ensure that your PC’s date and time are
correctly set prior to setting the Scene Controller time for FlexiDim™.
Firstly ensure that the PC is connected to the FlexiDim™ system.
From the Download menu, select Set Scene Controller Time.
This will display the current PC date and time, and ask you to confirm that this is the
information that you want to send to the Scene Controller.
Note that once the Scene Controller time has been set from your PC, it will be maintained by
FlexiDim™’s internal clock, even in the event of a power failure.
If you are unsure about the accuracy of the Scene Controller’s clock, it can be reset at any time
using the procedure described above.

Daylight Saving
Once the Scene Controller time and date have been set, then changes for daylight saving (the
change between GMT and British Summer Time) will be taken care of automatically.
When the clocks move forward by one hour to BST in Spring, the change occurs at 1am on the
first day of BST (always a Sunday). FlexiDim™ knows about this and will automatically forward
its internal clock by one hour to 2am.
Note that any FlexiDim™ events that are scheduled to occur during the hour that is lost when
the clocks move forward will be ignored.
When the clocks move back by one hour to GMT in Autumn, the change occurs at 2am on the
first day of GMT (always a Sunday). FlexiDim™ knows about this and will automatically move its
internal clock back by one hour to 1am.
Note that any events that are scheduled to occur between 1am and 2am will be repeated after
the clocks have gone back.
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APPENDIX A: IN THE EVENT OF FAILURE…
FlexiDim™ is designed to be trouble-free to install and commission, however there is always
the possibility of component failure in any complex piece of electronic equipment.

Electronic Component Failure
Before assuming that a FlexiDim™ system component has failed, check the obvious things such
as cabling and power. In particular, the polarity of the A & B connections on the data cables is
important. Obviously, the polarity of 12V and 0V is important as a reversed connection here
may result in damage to FlexiDim™ components.
The post-installation tests described in the previous sections will have identified the part of
the system that is causing the problem. The order of the tests is important, as some tests rely
on the correct functioning of previously tested components.
The most common problem at installation will be wiring errors, and the majority of fuses used
within the system are electronic self-resetting types.
Mains wiring should of course be checked in accordance with the current regulations.
In the event of a suspected defective unit, please contact JCL. Have the Site ID (printed on the
Scene Controller) and the Module ID (if relevant) to hand.

Defective Unit Replacement Process
In the event that a FlexiDim™ unit needs to be replaced, the replacement unit will be supplied
free of charge, provided that the unit is within the 5-year warranty period and the defect is due
to failure of the unit and not external causes. Otherwise units are replaced as per the current
price list.
Note that for any items replaced under warranty, the defective unit must be returned to JCL in
an agreed timeframe to avoid being charged for it at the current price.
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APPENDIX B: ADJUSTING THE SWITCH PLATE LED
BRIGHTNESS

To set the brightness of the LED in the switch plate:
 Press buttons 1 & 4 together and the LED will go off.
 Now press and hold buttons 1 & 4 together until the LED comes back on (this will put the

switch plate LED into programming mode).
 Release buttons 1 and 4.
 Use the dim up and dim down buttons to set the LED to your preferred brightness.
 Once you have reached the required brightness setting, press the On/Off button once to

save.
 To change the brightness at any time, start again at step 1.
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